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Abstract 
 
The following document presents a training manual on CoventorWare Modeling of an Energy Harvester 
in section 1.Tthe sane device is used as a training example for MEMS+ in section 2. Both sections are 
material for HandsOn. The Section 3 is the SEMulator3D tutorial which is made of slides and Live 
exercises. 
 
 

Public introduction1

 
 

 
 
 
 
  

                         
1  According to Deliverables list in Annex I, all  restricted (RE) deliverables will contain an introduction that will be 
made public through the project WEBsite  
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1 PZT ENERGY HARVESTER DESIGN IN COVENTORWARE 
1.1 Introduction 
As wireless sensor nodes become smaller, their energy supply is a limiting factor for further 
miniaturization as integration density is limited by the space requirements of the energy storage 
system. MEMS based vibration energy harvesters, such as the one shown in this example, are 
becoming a key enabler for further miniaturization and deployment of energy autonomous 
sensor nodes. Among existing methods, piezoelectric harvesting is the more studied thanks to its 
promising results. 
 
The device is made with the SINTEF MoveMEMS design kit. It is based on a PZT stacked on a 
SOI wafer. A description of the MoveMEMS process is also given in the Using CoventorWare 
manual, starting on page U4-24. 

 
Figure 1.0 Process description 

 
1.1.1 PZT cantilever with Si Proof mass 
The piezoelectric cantilever consists of a multilayered film of SiO2/ Pt/ PZT/Au deposited on a 
silicon beam of nearly 8 microns of thickness. The silicon substrate is used to make a proof mass 
to improve sensing of environmental vibration or movement by decreasing resonant frequency. 

Au-Cr Top electrode 
 

PZT CSD 

SOI wafer 

Pt-Ti 
 

 

themal oxide 
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The device is similar to the one published by Shen et al (D. Shen, J.-H. Park, J. Ajitsaria, S.-Y. 
Choe, H.C. Wikle III, D.-J. Kim "The design, fabrication and evaluation of a  (see picture 
below)). The process is also based on PZT on SOI, yet the thicknesses are different so this 
exercise is made with other dimensions and results are not compared.  

 

 
 
1.1.2 Tutorial Overview 
This tutorial is organized into three exercises, which demonstrate various techniques: 
 
Exercise 1: Technology setup 

• how to start a project 
• how to add material to a Material Property Database 
• how to create a suitable process 

 
Exercise 2: 3D modelling 

• how to draw a layout 
• how to create the 3D MEMS 
• how to mesh it 
•  

Exercise 3: Simulations in Analyser 
• how to run a piezoelectric modal analysis 
• how to run an harmonic with load 

  

Figure 1.1 Cantilever and proof mass 

Auburn University device (Ref 1) 
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1.2 Technology setup   
In this section you will start a CoventorWare project and get familiar with its environment. You 
will then review the default Material Property Database and add the necessary materials. Finally 
you’ll create a process file. 
 
1.2.1 Preparation 
The first design step is to define dimensions of the geometry. As can be seen in 

. 

 
Figure 1.2 Cantilever dimensions 
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1.2.2  Initialization 
During this initialization process, you will create a working project directory. This directory will 
contain all the files created in the tutorial, a project database for tutorial models, simulation 
results, and a settings file that saves window settings.  
 

Tasks Clues & Comments 

Start CoventorWare and load the tutorial 
called SINTEF_energy_harvester. 

Find the import tutorial icon.  
In the Project Browser, a default Settings file appears on the Settings 
file line. This settings file stores the combination of files as you put 
them in the function manager. 
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1.2.3 Load and update a Material Database 

Tasks Clues & Comments 

Go in the project directory and copy paste sintef_initial.mpd. 
Name the copy sintef_tutorial.mpd 

• MPD has automatic load and save. To create 
new files you must copy/paste one first. 

• Default MPD file mpd1.mpd is in Shared folder 
in your work directory. 

Load the sintef_tutorial.mpd. Browse to the project folder 

Add Au-Cr, PZT-CSD and Pt-Ti with following properties. See  Au-Cr properties 4, 5. 

 
Figure 1.3 Au-Cr properties 
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Figure 1.4 PZT properties 
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Figure 1.5 Pt-Ti Properties 

 
Additional Resources 
For more information on Material Properties Database see Using Coventorware Manual section 
2. 
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1.2.4 Create a process 
Once the materials are available in your Material Property Database you need to use or create a 
process description. Here we’ll update a process with new steps. 

Tasks Clues & Comments 

1.   Load the process sintef_initial shown in 

 and save it as sintef_tutorial.proc 

Exercise 1:   Pay attention if the step 
is a deposit or etch. You have the choice for 
etch type. 

 
Figure 1.6 Initial process 
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Tasks Clues & Comments 

2.   Add the 3 deposit steps as shown below to make the 
piezoelectric stack. 

Just note the thicknesses 

 
Figure 1.7 Deposit steps over oxidized SOI wafer 

Tasks Clues & Comments 

1.   Add the etch steps for the top electrode, PZT, bottom 
electrode and the backside and frontside etch 

On the backside etch you will etch the silicon 
substrate. 
b.   On the front side, you need to etch 3 layers: 

oxide_layer, buried_oxide and Si_handle. 

2.   Save the process. The validation will be made by creating the 3D 
model. 

 
Figure 1.8 Final Process 
 
Now you are done with the technology which is the basis of all CoventorWare project. You are 
ready to start building your device. 
 
1.2.5 Building the 3D model 
This exercise will guide you through the creation of your MEMS device in 3D. It explains how 
to draw a layout using the process you have chosen, then build the 3D solid, mesh it and finally 
name the relevant patches.  
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1.2.5.1   Layout Editor 
The layout Editor will start with the layer names defined in the process. 
 

Tasks Clues & Comments 

1.   Open the Layout Editor and review the layer parameters 
using the layer browser 

We will use only some layers of the SINTEF 
process. 
As defined in the process, ALIGN is ignored. 

2.   Change the necessary Dark/light option in layers Dark or Light will define if the shape is preserved 
or etch 

 
Figure 1.9 SINTEF process Final layer brower 
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Tasks Clues & Comments 

3.   Select the NOPIE layer and create a  rectangle of 200um 
in y and 1100um in x. 

4.   Select the FETCH layer and create a rectangle of 200um 
in y and 1500um in x. 

5.   Select BETCH and create a square of 400um side, and 
look 

 for its relative position.  

Use the arrow in the current layer menu 
b.   Use the rectangle tool on the left toolbar and 

draw or enter points. 
c.   Use Modify > object to change the rectangle 

corners positions. 

6.   Copy and paste the NOPIE rectangle into the TOPEL 
layer. 

7.   Copy and paste the FETCH rectangle into the  BOTEL 
layer. 

Use edit> paste to layer once the object selected. 
Place it and then correct its position or define its 
center while in the paste to layer menu 

8.   Save the library as Energy_harvester and the cell as 
cantilever 

The library is the .cat file storing the cells. One cell 
is just defined here but a hierarchy of cells can be 
created using the reference cell function. 

 
Figure 1.10 Energy Harvester Layout 
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1.2.5.2   Build the 3D model 
Once the layout and process established and saved, the next step is to build, manipulate and 
check the 3D solid. 
 

Tasks Clues & Comments 

1.   Create the solid and check it. Just click the build 3D icon and save it as 
harvester. 
b.   For checking different viewing tools can be 

used 

2.   Correct either the process or layout if some errors 
appear. 

See 

 as a reference. 
b.   In the drop-down arrow next build 3D icon 

choose the rebuild option to recreate the 3d 
solid from the modified process and/or layout. 
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Figure 1.11 3D model of the energy harvester 

 
1.2.6 Meshing 
To run analyses into Analyser, a mesh is of course required and also patch (surface) names. 
We’ll do this right now. 
 
 

Tasks Clues & Comments 

1.   Add all the layers in the mesh model Only one region should be created 

2.   Name the patches at fixed beam end as anchor. Use the zoom and rotating tools to be sure to 
select all the patches. You should have 6. 
b.   Right click and find set name function 

3.   Name the patches of the piezoelectric layer 
corresponding to the electrodes as topel for the Au-Cr 
electrode and botel for the Pt-Ti electrode 

Hide all layers except PZT to have a better 
viewing/selecting 

4.   Mesh with parabolic Manhattan bricks of 50 microns size 
in x and y and 0.3 in z. Define a maximum of 4 elements 
in the thickness. 

Right click and find mesher settings 
b.   Look in Advanced options 

5.   Save it as harvester_meshed.  
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Figure 1.12 Meshed Energy Harvester 

1.3 Simulations in Analyser 
A piezo harvester acts like a battery (capacitive power source). 

 
Figure 1.13: Equivalent circuit for piezo energy harvester 

Figure 1.13 shows an equivalent circuit for a piezo harvester. In closed circuit (CC) conditions 
(i.e. when Rload = 0), the piezoelectric layer generates a charge only and no voltage is generated 
across the electrodes. In open circuit conditions the piezoelectric layer outputs a voltage without 
any charge. Both these ideal conditions can be simulated with Coventor’s MemMech PZE 
solver. 
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To simulate CC the potentials on the electrodes are set to be equal, e.g 0V. MemMech will solve 
for the charge on each electrode generated by the reverse piezo electric effect. To simulate OC 
one electrode is set to TiePotential, the other to a potential, e.g. 0V. MemMech will solve for 
the unknown potential on the electrode that has the TiePotential specified and charge for the 
electrode that has potential specified. 
 
Note, the MemMech PZE solver must have either a charge or voltage specified on each 
electrode. To simulate OC conditions one might therefore specify zero charge on each electrode. 
However, CoventorWare does not have the BC option to specify charge in the GUI. However, if 
no charge (or voltage) is specified, the solver assumes 0 total charge. So you can specify a zero 
charge indirectly by not setting a voltage boundary condition on an electrode. 
Note also that, the surfaces of the piezoelectric layer are covered with a conducting (metal) layer 
to allow electrical connection. This electrical layer also enforces an equipotential over the 
underlying surface of the piezo. To enforce this condition in the MemMech PZE solver, use the 
tie potential boundary condition to constrain a constant voltage over the electrode. 
 
1.3.1 Running a mechanical analysis 
 

Tasks Clues & Comments 

1.   Open Analyser and run a mechanical modal analysis on 
the harvester model with the settings described on Figure 
1.14 

This analysis does not include piezoelectric effect. 
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Figure 1.14 Mechanical modal analysis 

Tasks Clues & Comments 

2.   Look at 3D results and note the frequencies and mode 
shapes. (see Figure 1.15) 

The piezoelctric effect is ignored in a mechanical 
analysis. These modes are purely mechanical. 

3.   In the Tables choose mechdomain. Look at the 
maximum displacement. 

This 91 um displacement in z is due to residual 
stress. 

Set the memory at maximum 80 % of your 
available RAM. 
32 bits systems are limited to 3GB 

Change the default to all available . 
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Figure 1.15 Mechanical Resonant modes 



 
Page 21 

 
 

 

 

 
1.3.2 Running a piezoelectric modal analysis 

Tasks Clues & Comments 

1.   Run an open circuit piezoelectric modal analysis the 
settings described on 

. 

This piezoelectric BCs simulate sensing behavior 
where the top electrode gets a voltage thanks to 
applied stress 

2.   Look at results and note the new frequencies and max 
displacement. 

3.   Run a query to get the voltage on topel. 

The frequency shift is due to piezoelectric effect. 
The residual stress impact differs and the 
displacement is only 86 um.  
b.   Note the piezo bricks have only 20 nodes 

instead of the 27 node of standard parabolic 
bricks. So results are inherently slightly 
different. A mesh convergence study is needed 
to validate them. 
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Figure 1.16 Piezoelectric modal analysis settings and results 

 
1.3.3 Running an harmonic with resistive load 

Tasks Clues & Comments 

1.   Run a piezoelectric harmonic analysis around the first 
mode of the open state with 1G acceleration on Z and a 
resistive load of 100k ohms with the settings described 
on  Harmonic analysi. 

The acceleration is an harmonic BC. Keep surface 
settings.  
b.   Go in circuit elements to set a resistor between 

the 2 electrodes. 
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Figure 1.17 Harmonic analysis with circuit element resistor settings 

 

Tasks Clues & Comments 

2.   Look at results plots for displacement and power. The resistor plays a damping role in the analysis. 
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Figure 1.18 Harmonic Analysis Results 

 
1.3.3.1    References 
 
1. D. Shen, J.-H. Park, J. Ajitsaria, S.-Y. Choe, H.C. Wikle III, D.-J. Kim "The design, 

fabrication and evaluation of a MEMS PZT cantilever with an integrated proof mass for 
vibration energy harvesting", J. of Micromechanical and Microengineering, vol.18, April 
2008 

2. To find documentation please go to: Start > All Programs > Coventor > 
CoventorWare2010 >Documentation or browse to 
...\Coventor\CoventorWare2010\docs 
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2 PZT ENERGY HARVESTER DESIGN IN MEMS+ 
2.1 Introduction 
As wireless sensor nodes become smaller, their energy supply is a limiting factor for further 
miniaturization as integration density is limited by the space requirements of the energy storage 
system. MEMS based vibration energy harvesters, such as the one shown in this example, are 
becoming a key enabler for further miniaturization and deployment of energy autonomous 
sensor nodes. Among existing methods, piezoelectric harvesting is the more studied thanks to its 
promising results. 
 
The device is made with the SINTEF MoveMEMS design kit. It is based on a PZT stacked on a 
SOI wafer. A description of the MoveMEMS process is also given in the Using CoventorWare 
manual, starting on page U4-24. 

 
Figure 2.1 Process description 

2.1.1 PZT cantilever with Si Proof mass 
The piezoelectric cantilever consists of a multilayered film of SiO2/ Pt/ PZT/Au deposited on a 
silicon beam of nearly 8 microns of thickness. The silicon substrate is used to make a proof mass 
to improve sensing of environmental vibra ions or movements by decreasing resonant frequency. 
The device is similar to the one published by Shen et al (D. Shen, J.-H. Park, J. Ajitsaria, S.-Y. 
Choe, H.C. Wikle III, D.-J. Kim "The design, fabrication and evaluation of a  (see picture 
below)). The process is also based on PZT on SOI, yet the thicknesses are different so this 
exercise is made with other dimensions and results are not be compared.  

Au-Cr T o p electrode

PZT CSD

SOI wafer

Pt-T i

themal oxide
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Figure 2.2 Cantilever and proof mass 
 
2.1.2 Tutorial Overview 
This tutorial is organized into three exercises, which demonstrate various techniques: 
 
Exercise 1: Technology setup 

• how to start a project 
• how to use a design kit 

Exercise 2: Design in Innovator 
• how to parameterize dimensions 
• how to create the 3D MEMS with components 
• how to connect components 
• how to apply Boundary Conditions 

Exercise 3: Simulations in Cadence 
• how to run a piezoelectric modal analysis 

 
 
2.2 Technology setup   
In this section you will start a MEMS+ project and use The SINTEF MoveMEMS design kit. 
 

Auburn University device (Ref 1)
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2.2.1 Preparation 
The first design step is to define dimensions of the geometry. As can be seen in 

. 

 

 
Figure 2.3 Cantilever dimensions 

 
2.3 3D Device Creation Guidelines 
The Section 6 of the MEMS+ User Guide and Reference has a description for each component 
used in this tutorial. 
 
2.3.1 Initialization 
The MEMS+ interface offers access to all its modules through a single console. They include the 
Material Database, the Process Editor, Innovator, and Scene3D (this one appears when opening 



 
Page 28 

 
 

 

 

simulation results). See 

 
Figure 2.4 MEMS+ environment 
 . 

 
Figure 2.4 MEMS+ environment 
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Tasks Clues & Comments 

1.   Start MEMS+. 
2.   Explore the interface, change options and move menus 

to create the environment as seen in 

 
2.   Figure 2.4 MEMS+ environment 
2.    . 

You can select the subwindows and displace them 
by dragging anywhere. 

 
2.3.2 Modules 
2.3.2.1   Material Database 
The first step in creating a design is to enter the material properties associated with the 
fabrication process in the Material Database, which stores materials and their properties in a 
.mmdb file. In the Process Editor, the user associates the process with the material database file, 
and the material list stored in that file becomes available in the individual steps of the process. In 
turn, the material properties of the selected materials are taken into account in the device 
simulation. The user can create a material database or can select and modify an existing 
database. 
 
2.3.2.2   Process Editor 
The second step in creating a design is to use the Process Editor to create a description of the 
sequence of steps involved in the fabrication process. The user creates the sequence by selecting 
prototype steps from the Item Library. Each step has parameters that must be specified. For 
example, for deposit steps the user must specify the material to be deposited and the deposit 
thickness. For etch steps, the user must specify a mask and an etch operation by layer, material, 
or depth. In Innovator, the user selects this process file so that individual components can be 
assigned to the process deposit layer(s). 



 
Page 30 

 
 

 

 

2.3.2.3   Innovator 
Innovator allows users to assemble their MEMS device using a library of parametric 
components. As components are added, the user sets the dimension and layer information. Each 
component has a rich set of parameters that can be incorporated in a P-cell implementation. The 
component then appears on the canvas as the user defined it. Any mistakes in dimensions or 
orientation are immediately apparent to the user. When the model is complete, the user can 
export a layout in GDS or a solid model in SAT format or import the MEMS model into a 
Cadence Virtuoso P-cell or a schematic. 
 
2.3.2.4   Scene3D 
Scene3D allows users to import and visualize results from Cadence Virtuoso. This module is 
only accessible then a result file is selected. Users will be able to visualize DC, DC sweep, AC, 
and transient results with Scene3D. In Cadence, when the user creates a schematic using a 
MEMS+ symbol, and then simulates that schematic, Cadence produces results files with the 
same name as the Innovator schematic used to produce the MEMS+ symbol. Those result files 
can then be opened in Scene3D. 
 
2.4 Use a design Kit 
When MEMS+ is first launched, the Innovator tab is active. All MEMS+ components require a 
valid Material Database and process file as input. In the next steps you will load the SINTEF 
Material Database (.mmpd file) and MoveMEMS process flow (.proc file). The 3-D schematic 
file is dependent on the material database and process files, so if you select a 3-D schematic file, 
MEMS+ automatically loads the material database and process file used to create that schematic. 
Clicking on either the Material Database or Process Editor tabs will display the associated files.  
 

Tasks Clues & Comments 

1.   Click on the Material Database tab and load the 
SINTEF_MPD.mmdb. 

a.   Use the “replace” icon from the menu bar 
b.   The SINTEF_MPD.mmdb is stored here: 

C:\Coventor\MEMS+1.0\Examples 

2.   Review properties and check they are the same as 
shown in next pages. 

a.   In the Material Properties sub-window make the 
Expression column appear by right-clicking on 
top bar. 

 
Once the materials are available in your Material Property Database you need to use or create a 
process description. Here we’ll load MoveMEMS process. 
 

Tasks Clues & Comments 

1.   Load the process MoveMEMS.proc shown in Figure 2.5. 
2.   Review the steps.  

a.    
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Figure 2.6 MoveMEMS process as described in MEMS+ 

 
Now you are done with the technology which is the basis of all MEMS+ project. You are ready 
to build your device. 
 
2.5 Design in Innovator 
This exercise will guide you through the creation of your MEMS device in 3D. It explains how 
to build the geometry from the MEMS component library, create mechanically and electrical 
connections, and expose variables of interest so that they can be changed in the simulator.  
 
2.5.1 Let’s parameterize! 
In MEMS+ you can define variables in the variable table. Variables names can be created as 
unique names or share a common group name. 
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Tasks Clues & Comments 

1.   In the innovator tab, Save the model as Harvester  

2.   Add the variables to the model as shown in 

 
2.   Figure 2.7 Var below. 

a.   Right click on Variables and add a group or a 
variable as needed. 
 Some limits can also be added for each 

variable. This allows you to integrate some 
design rules directly in the 3D Schematic 

 You can also define logical statement like 
If...then...else. It is written with the syntax: 
if(a<=b,c,d) 

3.   Expose beam and mass groups to enable their direct use 
in the simulator. 

When opening the MEMS+ device properties you’ll 
be able to change the exposed parameters. 

 
Figure 2.7 Variables 

 
 
2.5.2 Create the 3D model 
In this section you will use one rigid plate component to create the mass and one flexible plate to 
model the piezoelectric beam.  
 
 
 
 
 
 
 

added 
variables 

 variables 
defined in the 
MPD 
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Tasks Clues & Comments 

1.   Open the help and browse to the components properties a.   Review the parameters of each component 
while adding them for better understanding. 

2.   Add one rectangular plate standing for the beam and 
name it PiezoBeam. 

a.   Right click on Components and select Add 
 The plate is flexible and the number of 

mechanical connectors (18) is given by 
orders in x and y. 

3.   Add a piezo layer and name the 2 added electrode 
connectors top and a bottom. 

a.   Again just right click on plate.....the piezo is 
recognized as PZT automatically 

b.   Use electrical viewing mode to identify E1 and 
E2. 

 
Figure 2.8 Beam properties 
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Tasks Clues & Comments 

4.   Add one rigid plate composed of two rectangular 
segments and name it Mass. 

a.   Use the properties of 

 
a.   Figure 2.9 Mas.  
b.   The layers are given in the picture below for 

both segments. 
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Figure 2.9 Mass two segments properties 

 
2.5.3 Mechanical connection 

Tasks Clues & Comments 

1.   Connect the  mechanical connectors of the plates 
together. 

a.   Use the Mechanical Connector viewing mode. 
b.   Use the Autoconnect and place the point at 

beam end 

2.   Fix the beams end that act as anchor. a.   Use the fix icon. The connectors become yellow 
when selected and grey once fixed. 
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Figure 2.10 Mechanical connection 

2.5.4 Expose all needed information 
 

Tasks Clues & Comments 

1.   Expose the Inputs : acceleration and angular velocity These will be input in Cadence environment to 
excite all DOF for the modal analysis. 

2.   Expose the electrodes These will become pins in the simulator so that the 
device can be driven or sensed. 
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You have finished the design. The device should match that shown below on 

 
Figure 2.11 Final Device. 
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Figure 2.11 Final Device 

 
2.6 Simulations in Cadence 
This section demonstrates how to import a MEMS+ model into Cadence Virtuoso and then run 
an AC, DC, and transient analysis on a schematic which includes that model. It is not intended to 
be a detailed tutorial on how to use Cadence Virtuoso; for details on how to use the Cadence 
Virtuoso interface, see the Cadence Virtuoso online documentation. 
This section of the tutorial assumes that you have Cadence Virtuoso installed and configured to 
run with MEMS+, and that you are familiar with Cadence Virtuoso. 
 
2.6.1.1   Additional Ressources 
For more information on configuring Cadence for MEMS+ see Section 3 of the MEMS+ 
Installation. 
 
2.6.2 Creating the Schematic 
In this section we will cover the Cadence Library Manager,  
Schematic: MEMS+ schematic Import. Creation, parts library, wiring, 
Layout: Cadence tech file, display resources, GDS import/export, shape creation, hierarchy 
references, Pcells, LSW manipulation, F3 key, ruler, world view (and other tools). 
 
2.6.2.1   MEMS+ import into Cadence 
The first step to simulating a MEMS+ model in Cadence is to import it into the Cadence 
Virtuoso environment. 
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Tasks Clues & Comments 

1.   Start Cadence Virtuoso, and open the Library Manager. a.   At our Paris office, we have created a bash 
shell which set up the environment for MEMS+ 
and launch Virtuoso. Just type cadence610 in a 
terminal. 

b.   Once opened, select Tools > Library Manager. 

2.   Import the technology from MEMS+ using command 
Create Tutorial Tech library from process and name it 
MoveMEMS 

a.   Use the MEMS+ menu in the library manager 
b.   In the dialog that opens, specify a technology 

library name and browse to the MoveMEMS 
process file. 

3.   Import the harvester MEMS+ model into the technology 
library you have just created. 

a.   Select the technology library and go in MEMS+ 
> Import Innovator 3D Schematic. 

b.   Make sure the Layout and Model options are 
selected 

 

 
Figure 2.12 Import the process and device 

 

Tasks Clues & Comments 

1.   Open the layout, select one suspension arm and open its 
properties. 

Note the layers in the LSW are taken from the 
process description; see Error! Reference source 
not found.. 

2.   Open the symbol and check all exposed connectors are 
set as pins then open its properties. 

a.   Note that the symbol has 8 pins: the 6 
mechanical inputs and the 2 electrical pins; see 
Error! Reference source not found.. 

b.   Edit > Properties > CellView 

 

all the 3 .mmdb, .proc, .3dsch must 
be in the same folder 
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Figure 2.13 Harvester Layout 

 
Figure 2.14 Harvester symbol 
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2.6.2.2   Basic schematic creation 
We’ll start to study the MEMS only by adding sources on the harvester pins. 
 

Tasks Clues & Comments 

1.   Create a new cell named harvester_testbench with the 
schematic of Error! Reference source not found. using 
vdc voltage source, resistor res and gnd for the ground. 

a.   Work in the MoveMEMS library 
b.   Copy paste vdc source and just change its cell 

name for gnd and you’ll have the updated 
component as they are all in the same library. 

2.   Set the voltage on the DC electric pin to 0. No actuation and closed state modelling. 

3.   Check and Save and correct possible errors. Read the virtuoso log CDS.log for hints and ask for 
help 

 
Figure 2.15  Test schematic for Harvester component 

 
2.7 Simulations 

Tasks Clues & Comments 

1.   Turn on the sources on the accelerations and angular 
velocities for the AC modal analysis.  

Set the acmag of vdc sources to a non-zero 
value...1uV is fine. Keep the acphase and vdc to 0 
for all 

2.   Launch the simulator ADE L.  

3.   Go in Setup > Model Libraries and browse to the 
varactor_mems.scs file (see 

This is to indicate the location of the MEMS+ 
device to Cadence simulator so it can netlist the 
complete schematic. 
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3.   Figure 2.16 Lin). 

 

 
Figure 2.16 Link Cadence to MEMS+ model 
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2.7.1 Modal analysis 

Tasks Clues & Comments 

1.   Set an AC analysis from 100 to 10k with 10k number of 
steps in a linear mode.  

 Check you get the same line as in  
Figure 2.17 . 

2.   Set the gmin value to 0 : In the ADE window, select 
Simulation > Options >Analog. In the Simulator Options 
dialog that opens, click on the Algorithm tab and Set the 
gmin value to 0. 

The gmin parameter controls the creation of 
additional conductances across each and every 
nonlinear device of the netlist. Its purpose is to 
facilitate the convergence of the solver. However, 
on typical MEMS devices, the default alue of 1e-12 
is high enough to significantly affect the precision 
of a simulation with a MEMS+ model. It is best to 
run simulation involving MEMS+ devices with gmin 
set to zero. However, if you need gmin to be set to 
have the simulator converge, please verify its 
effect on the MEMS device. 

3.   Set the Rload to 1T (1 teraohm)  

4.   Save this session as a CellView and name it ac. so you’ll keep your settings 

5.   Start the simulation and check results are the one in  
5.   Figure 2.17 . 

 

6.   Browse results once the analysis is done to find signals 
inside a component. In this case open ac-ac and open 
instance I0 (MEMS reference in virtuoso) 

a.   Go in Tools > Results Browser and double click 
ac_ac then I0 
 Note the instance number I0 and the 

connector number M6 may be different in 
your case. 
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Figure 2.17 AC analysis 

 
Figure 2.18 AC signals plot 
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Tasks Clues & Comments 

7.   Back into MEMS+ open DC results into Scene3D Use open icon and choose the file with the name  
extended by .dc. 

8.   Measure the maximum displacement at device tip  

9.   Open AC results into Scene3D. Same with .ac 

10.  Use the graph tool to place the view at the peak 
frequencies and animate the 2 resonant modes found. 

a.   To add signals select the part in the component 
tree and drag it in the new graph 

b.   Right click to use Move progress bar here and 
Add data label. 

c.   Exaggerate displacements and increase the 
scales for a better viewing. 

 
Figure 2.19 Resonant modes in z and rx/ry 
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3 USING SINTEF MOVEMEMS DESIGN KIT INTO SEMULATOR3D 
 

Slide 1

Process Emulation 
with SEMulator3D™

SINTEF MoveMEMS training

 
 

Slide 2

Overview

• Presentation (20 minutes)
– What is Virtual Fabrication
– What is SEMulator3D
– Selected Use Cases

• Demonstration on SINTEF MoveMEMS (10 minutes)

• Hands-on Exercises (30 minutes)
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Slide 3

What is Virtual 
Fabrication?

2-D layout

Move wafer thru line,
following recipe

(partial or full sequence)

Sample, 
image,

measure

Processed
wafer

Blank
wafer

Actual Fab

Mimic equipment
to build 3-D model

(partial or full sequence)

Virtual Fab 
software

3-D model

Visualize, 
image,
measure

Rectangular
area of interest

 
 

Slide 4

Who uses/needs 
virtual fabrication

Process Development Team
Model the whole process sequence, 
including CMOS
Find problems before mask tapeout 
or running wafers
Save wafers ($$$) and time

Device Designers
Silicon-accurate 3-D models for input 
to analysis tools
Design Review

Technical Writers
 An easier way to add realistic 

3-D graphics for more effective 
documentation

Example: DLP Mirror
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Slide 5

Visualization 

Simulation Mesh

builds voxel models by
applying a sequence of 

primitive operations

3D Modeling Engine

Voxels are 3D pixels

Customizable to 
any process technology

What is
SEMulator3D

GDSII Layout

Process Description

A modeling tool used by leading MEMS and semiconductor fabs

 
 

Slide 6

NURBS surface

Alternative 
3D Modeling Approaches

Solid Modeling – Analog
 Exemplified by Pro/E, SolidWorks, 

Solid Edge, CATIA, etc.  
 Surfaces are modeled with 

mathematical shapes (planes, 
cylinders, spheres, NURBS…)

Voxel Modeling – Digital
 Exemplified by SEMulator3D 

and medical image processing
 Volume is filled with uniformly 

sized cubic voxels ≅ 3D pixels

Section of a voxel model

Advantages of SEMulator3D voxel models 
for semiconductor applications

Fidelity – faithful to real process technology

Robustness – modeling operations do not fail

Scalability – modest CPU and memory req’s; 
(model build from transistor to to wafer-level)
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Slide 7
SEMulator3D Layout Editor

Start with 2-D layout

Magma Camelot Bridge
(formerly Knights Technology)

Cadence Virtuoso Bridge

Import GDSII data from any source
 GDSII files
 Cadence Virtuoso Bridge
 Knights/Magma Camelot Bridge

or create your own with the 
included SEMulator3D layout tool.

 
 

Slide 8

Users can…

 Select a pre-defined, generic
process stack 

 Create a custom process stack 
using steps from the library

 Calibrate steps with data from 
cross-section measurements

 Create custom steps 
with Python scripting

 Import a process stack from an 
Excel spreadsheet or other data 
formats (e.g. XML) via Python

Add the 3rd dimension…

Process
Sequence

Parameters
of Selected

Step

Process Editor
Step Library
• Modeling Primitives
• Standard Steps

• CMOS Steps
• Fab Processes

Implant

 
 



 
Page 50 

 
 

 

 

Slide 9

Shallow Trench Isolation

Implant, Extension Implant

Spacer Formation

Lithography

Oxidation

Diffusion

CVD (many types)

(D)RIE Etch

Isotropic (wet) etching

Lift-Off

Sputtering, Evaporation

CMP

SEMulator3D Library
of Standard Process Steps

MEMS/CMOS process steps

 
 

Slide 10

Powerful 3D 
Visualization

 Interact with a 3-D view

 Create and animate 
dimensionally accurate
cross sections

 Color by material or by 
electrical connectivity

 Hide/show materials or 
electrical nets

 Take measurements

 Exaggerate scale in x,y or z

 Capture 3-D images

 Animate the fabrication steps

With the SEMulator3D Visualizer, you can
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Slide 11

Use Case – Design review

“We have now established a strict submission procedure within Baolab 
for all the foundry runs, and one imperative step is to simulate the whole 
die micromachining process using SEMulator3D and to visualize the 3D 
result using the mechanical coloring scheme, and this must be included 
in the final report.”

 
 

Slide 12

Use Case - Connectivity Check

Colored by material

Design courtesy 
of QinetiQ

Colored by electrical connection

CMOS-MEMS Chip
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Slide 13

Top view of SEMulator3D model

DRIE Oxide Mask

Design Error

Visual inspection of SEMulator3D 
model showed isolation trench 
structure would have been 
improperly exposed to subsequent 
DRIE

Oxide

Metal

Example: A design error that was caught before mask tape-out (XFAB)

Use Case - 3D design check

 
 

Slide 14

Cut line for cross section

During development of X-FAB’s technology, undesired pockets formed 
in mechanical layer during release etch

Detailed 3-D process model of the 
protective oxide layer confirmed the 
hypothesis about the process failure:
The release etch for the movable parts 
was etching through thin spots in the 
protective oxide layer

3-D Model

Use Case - Process Development
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Slide 15

Process Documentation 
and Training

The Traditional Way – Static 2D Cross 
Sections
 Created in a drawing program or PPT

 Not to scale; not scalable

 Manual => High effort to reproduce the 
graphics

The New Way – Interactive 3D Views
 Created with SEMulator3D
 To scale, supports interactive 

measurements
 Quickly and automatically re-generate

for new design & processes and variations
 Automatically generate ppt-slides
 New free viewer (2011 version)

Process 
Handbook

 
 

Slide 16

Beyond MEMS 
Processes…

SEMulator3D applies to
semiconductor processes as well
CMOS Logic

 FEOL and BEOL
 Digital and Analog/Mixed Signal
 Advanced processing nodes (22 and 15 nm)
 Current processing nodes (45 nm and larger)

Memory
 Advanced 6T DRAM cells
 Advanced flash memory cells

CCD Image Sensors

Hard Disk Read/Write Heads
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Slide 17

CMOS Logic Example:
Intel 45 nm Process

Presented at the IEDM2007 conference by K. Misty from Intel: A 45nm Logic 
Technology with High-k + Metal Gate Transistors, Strained Silicon, 9 Cu 
Interconnect Layers, 193nm Dry Patterning, and 100% Pb-free Packaging

SEMulator3D cross section

 
 

Slide 18

Scalability – model large area 
of interconnect on a desktop PC

Proprietary Voxel Modeling 
Technology

 Compression – enables the 
storage of hundreds of billions of 
voxels(!)

 Acceleration – dramatically 
reduces model build times. 

 Visualization – advanced 
techniques allow interactive 
manipulation of huge 3D models.
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Introducing 
SEMulator3D 2011

Many improvements and new features will be included:

Parallel Model Builds
A portable 3D model format and new 3D Viewer
New meshing capabilities
Automatic model re-build
Several new steps in the Process Editor
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SEMulator3D Viewer “Light”

• SEMulator3D is an excellent content creation tool.

• A “Light” version of the Viewer will allow anybody to view 
SEMulator3D models.

• Distribute 3D content to other people.

• Think of it like the Adobe PDF Reader.

Model Creator Archived SEM3D File

SEMulator3D Viewer Light
Colleagues

Customers

Management
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SEMulator3D 
Summary

A unique tool for semiconductor/MEMS manufacturers 
and their customers…
 Accelerate process development
 Save test wafers
 Save fab cycles
 Reduce time to volume
 Enhance yield

Volume Production

Process
Development

Process
Integration

Documentation
& Training

DfM for
Designers

Design
Review

Failure
Analysis

Yield
Enhancement

A new standard for internal and external communications
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Overview

• Presentation (20 minutes)
 What is Virtual Fabrication
 What is SEMulator3D
 Selected Use Cases

• Demonstration on SINTEF MoveMEMS (10 minutes)

• Hands-on Exercises (30 minutes)
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Demo SINTEF MoveMEMS

 
 

Slide 24

Hands-on Exercises (1)

Exercise 1

1. Open “SEMUlator3D Manager”
2. Load and open MoveMEMS process file

• “SINTEF_MoveMEMS_v0.vproc”
3. Adjust process file to SINTEF material properties (via File->Properties)

• “SINTEF.vmpd”
4. Specify layout (cantilever) and the topcell

• “H_k_cantilever_538_m.cat r.cat”
5. Build model with 0.1 resolution
6. Explore 3D viewer
7. Review process step-by-step

• Use ￪ ￬ of keyboard
8. Use x-section
9. Find and investigate x-section of

• Back etch cavity
• Anchors
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Hands-on Exercises (2)

Exercise 2 - build model for the Mirror layout

1. Open layout and review
2. Change for a DRIE back etch instead of KOH
3. Build model with higher resolution (0.01)
4. Change the visibility of substrate to hide it
5. Make a process step animation movie
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Hands-on Exercises (3)

Exercise 3 – Mesh the Mirror
1. Use GET tool to select only the Mirror device for emulation
2. Add a Volume Mesh to the process to create a unv format
3. Build model 0.1 resolution
4. Enable Mesh viewing in Zsplat
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